
Page1 

. Two hydrogen atoms meet. One says, "I've lost my Electron. 
" The other says "Are you sure?" The first replies, "Yes, I'm positive."  

MEETINGS are held on 
the third Wednesday of 

the Month, at  
Christ Church 

O’Halloran Hill 1708 
Main South Road 
O’Halloran Hill at 

7.30pm 
Visitors most welcome.  
Cost $2 per family, which 

includes the Newsletter 
plus coffee/tea and 

biscuits. 
Subscriptions for twelve 

months Single $18 
Family membership $24 
Novice and experienced 
computer users will be 

warmly welcomed  

SOUTHERN DISTRICTS COMPUTER 
USERS CLUB INC.  

 NOVEMBER 2007 

Carleen Jared         1st November 
 
Doris Hammond  19th November 

Southern Districts 
Computer Users Club 

Inc. 
For further information 
about S.D.C.U.C.Inc. 

 
Contact The Club President,  

Jim Greenfield 83824912 
 

Correspondence to 
The Secretary 
S.D.C.U.C.I. 

Box 991 
Morphett Vale  5162 

Email to 
roymarj@optusnet.com.au 

Club Web Site    http://videocam.net.au/sdcuci/
Editor Jim Greenfield 

 
PRESIDENT’S  PAGE 

 
This month’s demonstration will be by Colin Campbell. 

Colin will give an introduction to Microsoft Excel. 
 

Committee News 
 

The new committee met on the  8th of  November. We welcomed Alan Coe 
to the meeting.  
The committee is very appreciative of Alan becoming involved with the 
committee. 
Alan brings with him expertise in video editing programs.  
Following on from the meeting we met at Alan’s home to have an informal 
demonstration on the capabilities of Pinnacle Version 10. 
I was very impressed. As soon as I arrived home I loaded on Pinnacle 
Version 8 onto one of my computers. (I loaded Pinnacle on some time ago 
but was totally confused so I deleted the program). 
We look forward in the future to Alan demonstrating this program. 
 
 

Subsciptions 
 

Have you paid your Club Subscriptions?   The Treasurer will be delighted to 
record that you are a financial member for the next twelve months. 
 

Visit to The Adelaide Computer Club Inc. 
 

On 18th October six committee members visited The Adelaide Computer 
Club Inc. 
We were made very welcome and heard an excellent talk/demonstration on 
the history of Computer Games. 
We have invited Brian Wormald to give a talk/demonstration at our January 
Meeting. 
Brian is the Chairman of the Club, and also runs the BBS. (One of very few 
remaining BBS in Adelaide).  If you do not know what a BBS is maybe we 
will be able to persuade him to give a talk on BBS. 
 
 

 

Jim Greenfield                                            President    
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EARLY COMPUTING 

The Abacus 
The name Abacus derives from the Greek word ABAX meaning table or board covered with dust. 
The origins of the Abacus are buried deep in the history of mankind. It is known that in its 'modern' 
form it appeared in China in the 13th century AD.  The Chinese Abacus is made of 13 columns with 
2 beads on top (heaven) and 5 beads bellow (earth).  The Japanese copied the Chinese Abacus 
around the 17th century AD and adapted it to their more delicate way of thinking.  It has 21 
columns with 1 bead on top (heaven) and 4 beads below (earth).  The Abacus is still taught in the 
Far East as regular school training, and is used commonly in many places.  In 1946 a contest 
between a Japanese Abacist (Kiyoshu Matzukai) and an Electronic computer was held for 2 days 
resulting in an unmistakable victory for the Abacist.  The third modern form of the Abacus is 
Russian with 10 beads in 10 arched rows.  
  

Logarithms 
John Napier,: 1550 - 1617: Napier played a key role in the history of computing.  Besides being a 
clergyman and philosopher he was a gifted mathematician and in 1614 (not long before his death) 
he published his great work of Logarithms in the book called "Rabdologia".  This was a remarkable 
invention since it was able to transform multiplication and division (which were very complicated 
tasks at the time) into simple addition and subtraction.  His Logarithm tables soon became wide 
spread and were used by many people.  Funnily enough Napier is often remembered more by 
another invention of his nicknamed 'Napier's Bones'.  This was a small instrument constructed of 10 
rods, on which was engraved the multiplication table.  This simple device e was able tocarry out 
multiplication in a fast manner provided one of the numbers was of one digit only (i.e. 6 X 6742)  
 

The Slide Rule: 
The first Slide Rule appeared in 1650 and was the result of a joint effort by two Englishmen 
Edmund Gunter and the reverend William Oughtred.  This slide rule based on Napier's logarithms 
was to become the first analog computer (of the modern age) since multiplication and subtraction 
were figured out by physical distance.  This invention was dormant until 1850 when a French 
Artillery officer Amedee Mannheim added the movable double sided cursor, which gave it its 
appearance as we know it today.  
 

Two fish swim into 
a concrete wall. 
One turns to the 
other and says 
"Dam!" 
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Established 1991 
 

 0422 912 583 
Web Design               Hosting             Domain Names 

 
Personalised Service 
http://vcsweb.com 

eBay Sales  
We have great items for gifts such as Playstation & Gameboy accessories, phone covers,  

wheat bags, laser pointers, chess sets and more. 
Buy online and pick up locally! 

http://www.stores.ebay.com.au/vcswebgoodiesbox/ 
 

We can also sell items for you.   

Add a page number to every page in a Microsoft Publisher publication 
On the View menu, click Go to Background. 
Create a small text frame where you want the page number to appear.  
Create a text frame  
Type any text you want to appear next to the page number (for example, the word "Page"). Don’t type a 
number. 
On the Insert menu, click Page Numbers.  
Publisher inserts a pound sign (#). On foreground pages, this appears as a page number.  
On the View menu, click Go to Foreground.  
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Automotive Repairs 
 

ALL GENERAL  
MECHANICAL REPAIRS 

Brakes, Suspension, Clutch, 
Auto Trans Service, 

Wheel Balance & Repairs, 
New & S/Hand Tyres. 

SERVICE, TUNE & SAFETY CHECK 
(most 4 & 6 cyl. cars) - Includes plugs, 

points, oil, filter. 
 

U4/2 Somerset Circuit 
Lonsdale S.A. 5160 
 8186 0081 

Pensioner 
& Seniors 
Discount 

 MEETING RULES 
 

NO SMOKING    NO DRINKING   NO SWEARING 
 

We are allowed to use the facilities at Christ Church, O’Halloran Hill in return of a small fee plus respect for their property. We 
ask for your co-operation in respect to the above. While we can not control what our members do away from our club meetings, 
Piracy of copyright material can not be condoned at our meetings. 

Have you recently acquired, or do you just want to learn more about  
operating, your computer? 

The Club conducts classes on a wide range of subjects, at a very moderate charge 

The maximum number in aclass is five.  

(Our aim is to conduct the classes in a friendly non threatening atmosphere) 

Some of the classes that are available:- 

1. Basic Computing (Stage one and / or Stage Two) 

2. Advanced Word 

3. Internet workshops 

4. Digital Cameras 

For more information contact a committee member. 

 
 

 
EXCEL  TIPS 

Data Entry and Cell Formatting 
There are a few tricks to follow when 
entering data or formulae into cells. 
Excel automatically applies a data type 
and format as you type in 
information. You should be aware that: 
 Using a slash or hyphen (minus sign) 
between numbers gives a date 
format 
 Using a colon between numbers gives 
a time format 
 Preceding a number with a currency 
symbol (£, $ or €) gives a 
currency format 
 Including a comma in a number (eg 
1,500) gives a comma format 
 Having a percentage sign (%) at the 
end of a number gives a percent 
format 
 To get a fraction format, precede the 
fraction with 0 (or a number) then 
a space before the fraction (eg 0 1/3) 
 Preceding a number with a single 
quote (') forces it to be stored as text 
 Press <Alt Enter> to get a new line 
when entering data into a cell 
Note also that data stored as text ap-
pears left-justified in a cell (by default); 
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A Brief History of Spreadsheets 
by D. J. Power 

Editor, DSSResources.COM 

Spreadsheets have been used by accountants for hundreds of years. Computerized or electronic spreadsheets are of 
much more recent origin. Information Systems oral history and some published newspaper and magazine stories 
celebrate Dan Bricklin as the "father" of the electronic spreadsheet. In 1978, Harvard Business School student, Daniel 
Bricklin, came up with the idea for an interactive visible calculator (see email from Frankston, 4/15/1999a). Bricklin 
and Bob Frankston then co-invented or co-created the software program VisiCalc. We can look back and recognize 
that VisiCalc was the first "killer" application for personal computers. 
 

What is a spreadsheet? 

In the realm of accounting jargon a "spread sheet" or spreadsheet was and is a large sheet of paper with columns and 
rows that organizes data about transactions for a business person to examine. It spreads or shows all of the costs, 
income, taxes, and other related data on a single sheet of paper for a manager to examine when making a decision. 

An electronic spreadsheet organizes information into software defined columns and rows. The data can then be 
"added up" by a formula to give a total or sum. The spreadsheet program summarizes information from many paper 
sources in one place and presents the information in a format to help a decision maker see the financial "big picture" 
for the company. 

Beginnings and the "Tale of VisiCalc" 

In 1961, Professor Richard Mattessich pioneered the development of computerized speadsheets for use in business 
accounting. Some historical information on the computerization of accounting spread sheets using mainframe 
computers is discussed on Mattessich's web page "Spreadsheet: Its First Computerization (1961-1964)". Rene Pardo 
and Remy Landau co-invented "LANPAR" LANguage for Programming Arrays at Random in 1969. This electronic 
spreadsheet type application was used for budgeting at Bell Canada, AT&T, Bell operating companies, and General 
Motors. They received a US patent (no. 4,398,249) for LANPAR in August 1982 after 12 years of litigation. 
Mattessich, Pardoe and Landau's work and that of other developers of spreadsheets on mainframe computers probably 
had no influence on Bricklin and Frankston. Therefore, a history of the modern era of microcomputer-based electronic 
spreadsheets should begin with the "Tale of VisiCalc". 

The tale of VisiCalc is part myth and part fact for most of us. The story is that Dan Bricklin was preparing a spread 
sheet analysis for a Harvard Business School "case study" report and had two alternatives: 1) do it by hand or 2) use a 
clumsy time-sharing mainframe program. Bricklin thought there must be a better way. He wanted a program where 
people could visualize the spreadsheet as they created it. His metaphor was "an electronic blackboard and electronic 
chalk in a classroom."  

By the fall of 1978, Bricklin had programmed the first working prototype of his concept in integer basic. The program 
helped users input and manipulate a matrix of five columns and 20 rows. The first version was not very "powerful" so 
Bricklin recruited an MIT acquaintance Bob Frankston to improve and expand the program. Bricklin calls Frankston 
the "co-creator" of the electronic spreadsheet. Frankston created the production code with faster speed, better 
arithmetic, and scrolling. He also expanded the program and "packed the code into a mere 20k of machine memory, 
making it both powerful and practical enough to be run on a microcomputer". For more details check Dan Bricklin's 
email from May 12, 1999. 

During the fall of 1978, Daniel Fylstra, founding Associate Editor of Byte Magazine, joined Bricklin and Frankston in 
developing VisiCalc. Fylstra was also an MIT/HBS graduate. Fylstra was "marketing-oriented" and suggested that the 
product would be viable if it could run on an Apple micro-computer. Bricklin and Frankston formed Software Arts 
Corporation on January 2, 1979. In May 1979, Fylstra and his firm Personal Software (later renamed VisiCorp) began 
marketing "VisiCalc" with a teaser ad in Byte Magazine. The name "VisiCalc" is a compressed form of the phrase 
"visible calculator" (see email from Frankston, 4/15/1999b). 

VisiCalc became an almost instant success and provided many business people with an incentive to purchase a 
personal computer or an H-P 85 or 87 calculator from Hewlett-Packard (cf., Jim Ho, 1999). About 1 million copies of 
the spreadsheet program were sold during VisiCalc's product lifetime. Dan Bricklin has his version of the history of 
Software Arts and VisiCalc on the web at www.bricklin.com/history/sai.htm. Bricklin includes early ads and reviews 
and pictures of the VisiCalc packaging and screenshots. 

                                                                                                                     continued on next page 
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Opinions expressed in this newsletter do not necessarily represent those of the Southern Districts Computer Users Club Inc. nor does publication of an 
advertisement imply endorsement by the Southern Districts Computer Users Club Inc.  
 

While every attempt has been made to verify that the information in this newsletter is correct, the Southern Districts Computer Users Club Inc accept no 
responsibility for any inaccuracies. 
 
Likewise no member of the committee or member of the Southern Districts Computer Users Club will accept any liability for any damage occurring to a 
computer,  to any computer system and/or data from following instructions given in this newsletter. 

 

Let Evacom  Fix  it  Professionally 
Minimum charge applies 

FOR UP MARKET & UPGRADEABLE COMPUTERS, 

PROFESSIONAL REPAIRS AND UP-GRADES 

AT SENSIBLE PRICES 

———————!! Go To !!——————- 
!! Go to !! 

From previous page 

What about Microsoft Excel and Bill Gates? 

The next milestone was the Microsoft Excel spreadsheet. Excel was originally written for the 512K Apple 
Macintosh in 1984-1985. Excel was one of the first spreadsheets to use a graphical interface with pull down menus 
and a point and click capability using a mouse pointing device. The Excel spreadsheet with a graphical user 
interface was easier for most people to use than the command line interface of PC-DOS spreadsheet products. Many 
people bought Apple Macintoshes so that they could use Bill Gates' Excel spreadsheet program. There is some 
controversy about whether a graphical version of Microsoft Excel was released in a DOS version. Microsoft 
documents show the launch of Excel 2.0 for MS-DOS version 3.0 on 10/31/87. 

When Microsoft launched the Windows operating system in 1987, Excel was one of the first application products 
released for it. When Windows finally gained wide acceptance with Version 3.0 in late 1989 Excel was Microsoft's 
flagship product. For nearly 3 years, Excel remained the only Windows spreadsheet program and it has only 
received competition from other spreadsheet products since the summer of 1992. 
By the late 1980s many companies had introduced spreadsheet products. Spreadsheet products and the spreadsheet 
software industry were maturing. Microsoft and Bill Gates had joined the fray with the innovative Excel 
spreadsheet. Lotus had acquired Software Arts and the rights to VisiCalc. Jim Manzi had become CEO at Lotus in 
April 1986 and in July 1986 Mitch Kapor resigned as Chairman of the Board. The spreadsheet entrepreneurs were 
moving on ... 
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WHAT ARE SENIORS WORTH? 
Remember, old folks are worth a fortune –  
With silver in their hair, gold in their teeth, stones in their kidneys, lead in their feet and gas in their 
stomachs. 
I have become a little older since I saw you last, and a few changes have come into my life. 
Frankly, I’ve become quite a frivolous old girl.  I’m seeing five gentlemen every day.  As soon as I 
wake up, Will Power helps me out of bed.  Then I go to see John.  Next, it’s time for Uncle Toby to 
come along, followed by Billy T.  They leave and Arthur Ritus shows up and stays for the rest of the 
day.  He doesn’t like to stay in one place very long, so he takes me from joint to joint. 
After such a busy day, I’m really tired and glad to go to bed with Johnny Walker.  What a life!  Oh yes, 
I’m also flirting with Al Zymer. 
 
PS.  The preacher came to call the other day. 
He said that at my age I should be thinking about the hereafter.  I told him, “Oh, I do  -  all the time.  No 
matter where I am, if I’m in the parlour, upstairs in the bedroom, or down in the kitchen, I ask myself, 
“Now what am I here after?” 

An Avert from 1949 
Styled for today & priced for today 

 
 
 
Styled for today - and priced for today. This smart new Burroughs for only... $125.Your first glance will 
tell you that this Burroughs adding machine has 
style and class to lend a modern note to store or office. 
New square keys add sureness to the touch, wings to 
the fingers; the machine is pleasing in contour and color; the 
over-all appearance is an invitation to get work done. Then 
l o o k  a g a i n . . . m o r e closely... and note that this is no 
"cut-down" model but a full-size, full-value Burroughs 
with a totaling capacity of 939,993.99. It's tops for rugged 
durability and smooth operation. How much for this 
Burroughs beauty! Just $125*... two or three pennies a 
day spread over its long, useful life. You can buy it on 
easy terms, too-a small amount down, low monthly 
p a y m e n t s .  O t h e r Burroughs adding machines 
styled for today and priced for today include models 
with electric operation, direct subtraction, various 
totaling capacities. Call the nearest Burroughs office. 
Ask your Burroughs representative for a demonstration.Burroughs Adding Machine Co., Detroit 32, 
Mich.  
 
 
 
 

(On today's values 
approximatey $1300)  

Don’t fall for the hype and try to remember what Vista really stands for: 

Viruses 
Intrusions 
Spyware 
Trojans 
Adware 



Page8 

 

CHRISTMAS  
DINNER  

12th December, 2007 
 

FLAGSTAFF HOTEL 
 

6.30 p.m. 
 

Please place your name on the circulating sheet 

NB  Change of date and venue for December meeting 
 

To be held on  
 

December 12th 

 

 
HAVE A HAPPY OR SAD  FACE IN MICROSOFT WORD 

 
Simply type a colon followed by a right or left parentheses, then press the SPACE bar. Depend-
ing on what parentheses you press a circle with a happy or sad inside face will appear.  
Note from Editor: This is NOT an egg. This is a documented feature of Word.  

 
Try this in Word 

Open a new word document  
2. Type "=rand(200,99)" (without the quotes)  
3. Press enter  
4. Wait a few second and see  
5. try typing after "=rand" any variation from (1,1) to (200,99)to see different results; the first 
number being the repetition and second the number of times in a row... 


